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Exercise 10: Intermediate Cartographic Design 

In this exercise, you will produce four separate maps from a choice of eight 
using a variety of data. The goal of this lab is to expand your knowledge of 
map production in ArcGIS Pro and to introduce you to a variety of options, 
tools, and techniques for producing maps in this software package. This lab 
has been designed to expand upon introductory digital cartography lab 
exercises. If you are completing these labs for Sustainability 150: Digital 
Earth Lab at WVU, this lab will serve as the final lab project.  

 

Topics covered in this exercise include: 

1. How to produce a well formatted map 
2. How to edit and manipulate symbology of geospatial data. 
3. How to create a layer file 
4. How to design legends 
5. How to insert graphics into a map image 
6. How to edit scale bars 
7. How to add grids to a map frame 
8. How to insert multiple map frames in a map 
9. How to insert extent indicators 
10. How to improve labels in ArcGIS Pro 
11. How to export a map using post scripting 

 

Before starting this lab, you should know how to do the following in ArcGIS 
Pro: 

1. Add a new map layout to a project. 
2. Add a map frame to the layout and adjust the map frame size and 

position. 
3. Insert scale bars, north arrows, titles, and text.  
4. Change the symbology of vector and raster data layers.  
5. Change the name of data layers in the Contents Pane. 
6. Export your map as a graphic file. 

If you do not know how to complete these tasks, please complete or review 
a basic cartography lab for ArcGIS Pro (such as Exercise 3). If you know how 
to do these things, this lab should be appropriate for you.  

From previous cartography lectures or lab assignments, you should 
remember the general rules for making maps: 
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1. You should use the map space well and have a balance on the 
page. The layout should be neither too crowded nor too empty. 
Make sure you do not have a lot of empty space in your layout. 

2. Make sure you use an appropriate projection for the spatial extent 
of your map. 

3. The north arrow should be large enough to be interpreted, but not 
excessively large, as this is not the focus of the map. Simple north 
arrows are preferable to complex north arrows. In some cases, a 
north arrow may be misleading, such as when map projections 
cause the direction of north to vary over the map space. In such 
cases, you can use graticules or a coordinate grid instead.  

4. The scale bar should be legible and in appropriate units. Preferably, 
you should use breaks on multiples of five or ten. 

5. Appropriate titles and text should be provided. You should use a 
font that is legible and an appropriate font size. 

6. No file names should appear in the legend. All names should be 
edited to be meaningful. 

7. You should include all map layers in the legend that are required to 
understand the map. You do not need to include all layers. For 
example, it is often not necessary to include a base image or 
hillshade in the legend. 

8. If you are using someone else’s data in your map, it is important to 
reference the data source. You can do this using a text box. 

9. You should use appropriate colors and symbology for your layer 
features. It is important to think about the perception of color and 
symbols.  

10. If you are making a map to be printed or reproduced in black-and-
white, make sure that colors are distinguishable when printed as 
such. 

11. You should use colors with an appropriate contrast, so that they are 
discernable. 

12. Maps should not be provided in project files. Instead, they should 
be exported as a graphic file, such as JPEG, TIFF, or PDF. 

13. Remember that maps are a form of communication. So, your goal 
should be to appropriately communicate something to an audience. 
It is important to think about your audience. 

The goal of this lab is to expand upon these basic skillsets so that you can 
produce well formatted maps of a professional quality. We will introduce and 
explain some map production techniques as a series of tips. You will then be 
asked to produce four map layouts as the deliverables for this lab.  
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Some of the examples used here are demonstrated in this YouTube video: 
https://www.youtube.com/watch?v=j3Ih0MHq9Rc&t=7s. 

Tip 1: Editing and Manipulating Layer Symbology 

In ArcGIS Pro, it is best to prepare your layer symbology in the map before 
adding the map frame to a map layout. As a review, you can change the 
layer symbology by right-clicking on the layer in the Contents Pane and 
selecting Symbology. This will open the Symbology Pane. Within this Pane, 
you can change many features of 
the symbology. 

1. You can change the 
symbology. For example, you 
could display a polygon vector 
layer using the same color for 
each feature or you could 
produce a choropleth map, in 
which values or quantities 
from an attribute column are 
symbolized using different 
colors. You could also choose 
to show quantities using 
graduated or proportional 
symbols. For categorical data, 
you can display different 
categories using unique 
colors.  

 

 

https://www.youtube.com/watch?v=j3Ih0MHq9Rc&t=7s
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2. If you used a classified legend, you 
could change the classification 
method (Natural Break, Quantiles, 
Equal Interval, Standard Deviation, 
Manual, etc.), the number of 
classes, and the color scheme.  

 

3. In the label column in the table, you can change the label used for 
each category or classification bin by simply typing into the table.  The 
label will be used in the Contents Pane and in the map layout, 
including the legend. 

4. Clicking on the symbols in the symbol column will open the Format 
Symbol Pane and allow you to edit the symbol, such as the color, 
outline color, and outline width.  

Raster data layer symbology can 
also be changed using the 
Symbology Pane. For example, 
the symbology of a continuous 
raster can be altered from a 
stretched to a classified 
symbology.  
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The color scheme used to symbolize raster data can also be changed in the 
Symbology Pane. You can also edit the legend labels.  

 

You can also apply a color to symbolize NoData values.  
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Using the Stretch Method, you can change the data range to be dynamic 
based on what values are in the current display extent. This can be done by 
setting the Statistics option to DRA (dynamic range adjustment using 
statistics from the current display extent). This can be useful when you want 
to use the full range of colors in the color scheme in the display extent.  

 

Categorical raster data are 
symbolized using unique values, or a 
different color for each category. You 
can change the label and the 
color/symbol used to represent 
categories.  

You may find that the default 
symbology may not be optimal for 
your intended purpose. So, you will 
commonly need to manipulate 
symbology using the options 
available in the Symbology Pane.  

 

Tip 2: Changing Colors and Symbols 

You can change the symbol used to show points, lines, or polygons by 
double-clicking the symbology in the Contents Pane. This will open the 
Symbology Tab. You can then Use the Gallery or Properties to change the 
symbology. The image below provides an example of a point layer. Here, we 
have searched for airport symbols.  
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Alternatively, right-clicking on the 
symbol for the layer in the Contents 
Pane will open a menu that allows you 
to change symbol properties.  

So, there are many ways to change the 
layer symbology. Again, we would 
encourage you to experiment with the 
options available.  

 

 

 

 

 

Tip 3: Changing Layer Transparency 

You may want to make one of your layers partially transparent. For 
example, the image below was created by making a digital elevation model 
(DEM) partially transparent and displaying it over a hillshade image.  
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To add transparency to a layer, use the 
transparency slider under the Raster Layer 
Tab.  

 

 

Tip 4: Creating a Layer File 

Once you have created a layer 
symbology that you find to be 
effective, you can save it to a 
Layer File. This can be done by 
right-clicking on the layer in the 
Contents Pane then selecting 
Save As Layer File.  

 

Note: You are not saving a copy of the data. Instead, you are saving a file 
that stores the symbology for later use.  

If you would like to apply the saved layer symbology to a new layer, this can 
be done in the Symbology Pane using the Import Option.  
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Layer files offer a useful and efficient means for storing and saving data 
symbology for later use. For example, when you create a new data layer to 
share with a colleague, you could also provide a layer file so that the data 
can be symbolized as you intended. 

 

Tip 5: Legend Design 

You should already know how to add a legend to a map. Here, we will 
discuss some means to further edit and enhance legends. Legends are very 
important components of maps, so it is important that you think about how 
the legend is presented.  

Once a legend has been added to the map layout it can 
be resized and moved by selecting it. Once selected, 
you can move and resize it using the selection box. The 
legend should always be intentionally placed.  

Under the Format Tab for the legend, you can alter the 
legend in many ways including: 

1. Changing the fill and outline color. 
2. Changing the font style, boldness, size, and color. 
3. Changing the alignment of the legend. 
4. Changing the position and size of the legend.  
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You can also edit the legend by selecting it in the Contents Pane for the map 
layout. This should open the Format Legend Pane. In this pane, you can do 
the following: 

Under the Legend options: 

1. Change the name of the legend as displayed in 
the Contents Pane. 

2. Lock it or change the visibility of it on the 
layout. 

3. Add and show a legend title. 
4. Change how the legend is synchronized with 

the associated map. 

 

 

 

 

 

Under the Text Symbol Options: 

1. Change the text appearance. For example, 
you can change the font type, boldness, 
size, color, and case. You can also 
underline the text. 

2. Change the text alignment, such as 
changing the horizontal and vertical 
alignment or applying offsets. 

3. Rotate the text by a defined angle. 
4. Add a halo to the text. 
5. Add a shadow. 
6. Add callouts.  
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You can also change individual elements in a legend. 
Within the Contents Pane for the map layout, you can 
expand the legend element to see what features are 
included. If you click off a layer, it will no longer be 
shown in the legend. If you click a layer, the Format Legend Item Pane 
should open. This allows you to make changes to just this item in the 
legend, not the entire legend.  

For example, if you do not want to display the layer name or attribute 
heading for a layer in a legend, you can turn these features off in the Legend 
Items options. You can also change the arrangement of the legend 
elements. And the size of the symbology. Under the Text Symbols options, 
you can edit the text symbols as described above. 

 

There are many options available for editing legends and individual legend 
elements. The best way to learn is to simply experiment with the options 
available.  
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Tip 6: Inserting Graphics 

You can insert graphics, such as logos or 
graphs into a map layout. This is easy. To 
insert a graphic, navigate to the Insert 
Tab while the map layout is active and 
select Picture in the Graphics and Text 
Area. This will allow you to insert a graphic element from a file. Make sure 
that the graphic file you want to add is high enough resolution. You don’t 
want it to look blurry once the map layout has been produced.  

This menu also allows you to add additional map elements. For example, you 
can draw areal features (rectangles, circles, ellipses, and polygons), points, 
and lines. Once these features have been drawn, you can edit their 
appearance by clicking on them in the map space to open the associated 
formatting pane. For example, if you draw a rectangle, you can change the 
color, outline color, and outline size.   

 

Tip 7: Editing Scale Bars 

Like editing legends, you can also edit elements of a scale bar. Once a scale 
bar has been added and while it is selected, you can navigate to the Format 
Tab to edit it. This tab allows you to: 

1. Change the font type, boldness, size, and color. 
2. Change the scale bar alignment and size.  
3. Add a fill color. 
4. Add an outline and change its width and color. 

 

The Design Tab allows you to further edit the scale bar. Here, you can 
change the following: 

1. Resizing behavior  
2. Number of divisions 
3. Number of subdivisions 
4. Units of measurement 
5. Placement of measurement units 
6. How the measurement units are labeled (for example, miles vs mi) 
7. The frequency of marks 
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8. The position of the marks 
9. Frequency of numbers 
10. Position of numbers 

 

You can also manipulate the legend by selecting it from the Contents Pane 
for the map layout. This will open the Format Scale Bar Pane. Again, the 
default settings may not be optimal, so you may need to use these tools and 
settings to manipulate the scale bar to meet your needs. Again, we 
encourage you to experiment with the available options.  

Tip 8: Creating Graticules and Coordinate Grids 

You can add a longitude and 
latitude reference (graticules) to 
a map frame on a layout. You 
can also add coordinate system 
grids (for example, a UTM grid). 
With the map frame of interest 
selected, navigate to the Insert 
Tab and click the dropdown 
arrow next to Grid in the Map 
Frame area. This will open a list 
of available grids. Selecting one 
of these options will add it to the 
map frame.  

You can access the editing tools 
for the graticule by right-clicking 
on the grid in the Contents Pane 
and clicking Properties. 
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The grid can be edited. You may have to expand the map frame in the 
Contents Pane to see the grid element. This menu provides a set of options 
for editing the elements associated with the grid. Some of the features that 
can be changed include the following: 

1. The font type, size, boldness, and color of 
the labels 

2. Where labels will be placed 
3. The presentation of the coordinates (for 

example, degrees minutes and second or 
degrees and decimal degrees)  

4. The interval of tick marks, labels, and 
gridlines 

We have found that the Components options offer the most efficient means 
to edit grids.  
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Note: The projection used can have a large impact on the map layout and 
the patterns of the graticules or coordinate grid. It is important to think 
about what projection is appropriate for a map.  

Tip 9: Adding Multiple Data Frames and Inset Maps 

You may want to create a layout that contains more than one map frame. 
For example, you may want to add an inset map showing the location of 
your larger map within a broader geographic extent. You may want to add 
multiple maps to compare data or show change over time.  

The image to the right shows a 
layout in which an inset map has 
been added to show the extent of 
the larger map within a geographic 
area.  

 

 

 

 

This map provides an example of a layout in which one map frame has been 
duplicated to compare different outputs.  
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Adding multiple map frames to a layout is easy. Once the first 
frame is added, a second frame can be added by navigating 
back to the Insert Tab and selecting the dropdown arrow 
associated with the Map Frame Button. This will open a list of 
available maps within the project that can be added to the 
layout.  

Once frames have been added, they 
can be selected to change their 
position and size in the layout.  

If you want to pan or zoom the map 
within the map frame, you can right-
click on it and make it active. 

Once you have navigated within the 
map space, you will need to close the active map frame by clicking the 
Layout tab and Close Activation.  

 

 

Tip 10: Inserting Extent Indicators 

In is possible to indicate the extent of one map frame within another map 
frame. For example, you could highlight the location of your main map on 
the inset map. This can be done by adding an extent indicator.  

Extent indicators can be added by clicking on the Extent Indicator button 
within the Map Frame area of the Insert Tab when a layout is active. You will 
want to make sure the map frame to which you want the extent indicator to 
be added is selected. Using the dropdown arrow 
associated with the Extent Indicator button, you can 
select which map you want to indicate on the 
selected map. This will add an extent indicator.  



17 
 

To edit the added extent indicator, you 
will need to find it in the Content Pane 
for the map layout. It will be listed 
under the map frame to which it has 
been added.  

Clicking on it in the Contents Pane will 
open the Format Extent Indicator Pane 
so that it can be edited.  

The map below provides an example of an extent indicator. The red 
rectangle on the smaller state map shows the extent of the larger map 
above it. Note that the extent indicator symbology was changed using the 
Format Extent Indicator Pane. 
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Tip 11: Editing and Removing Map Frame Borders 

You may want to edit or remove the border around a map frame. To do this, 
click on the map in the Contents Pane for the map layout. This should open 
the Format Map Frame Pane. Click on the dropdown arrow next to Map 
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Frame then select border. This will provide Gallery and Properties options for 
changing the map frame border.  

 

Using the options available in the Format Map Frame Pane, you can also 
make changes to the map frame, background, and shadow. For example, 
you could add a shadow behind the frame. Again, it is worth taking some 
time to experiment with the options available.  

Tip 12: Improving Labelling 

There are many options for 
working with and manipulating 
labels. Here, we will just 
provide a brief introduction.  

 

First, it is easier to begin 
working with labels within a 
map as opposed to a map 
layout. So, you should 
navigate back to the map that 
contains the layer to which 
you are interested in applying 
labels. You will then need to 
click on the layer for which 
you want to add labels in the Contents Pane.  

Navigate to the Labeling Tab. This provides options for labeling features. 
Here are a few options available for labeling features: 

1. Turn labels on  
2. Pick an attribute column from which to obtain labels. 
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3. Choose scales at which to show or not show labels. 
4. Change the font type, size, boldness, and color of the labels. 
5. Make use of default label placement options 

Note: In ArcGIS Pro, the Mapplex Labeling Engine is used to label features. 
This engine considers rules and cartographic principles to label features.  

If you click on the arrow in the corner of the Text Symbol area of the 
Labeling Tab, this should open the Label Class Pane. This pane provides 
additional options for changing the text labels. You can also access this pane 
by right-clicking on the layer of interest in the Contents Pane and selecting 
Labeling Properties. 

 

This menu allows you to make changes to the label text using the Symbol 
options including the following: 

1. Changing the font type, size, 
boldness, and color 

2. Changing the positioning and 
alignment of the labels 

3. Rotating the labels 
4. Adding a halo 
5. Adding a shadow 
6. Adding a callout 
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You can also edit the location and 
placement of the labels using the 
Position options. 

Labeling positioning can be a complex 
topic. We will not cover positioning in 
detail here. However, feel free to 
experiment with the positioning options.  

 

Another topic that will not be covered here is using annotations. Under the 
Map Tab, you can use the Convert To Annotation button to convert labels to 
annotations. Annotations allow individual text elements to be edited and 
stored in a geodatabase. 

You may find that additional labeling may be required to obtain the desired 
results. Some of this editing may have to take place outside of ArcGIS Pro in 
vector graphics editing software, such as Adobe Illustrator. We will discuss 
how to export a file to a vector format for additional editing in vector 
graphics editing software below. 

 

Tip 13: Convert to Graphic, Group, Ungroup 

Some map elements can be converted to graphics. They can then be edited 
like graphics. Here we will provide an example with a legend.  

To convert a map element into a graphic, simply right-click on it and select 
Convert to Graphic.  
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Note: Once a map element has been converted to a graphic, it is no longer 
dynamic and will not automatically update as the map is changed. For 
example, if you convert a scale bar to a graphic then change the scale of the 
map, the legend scale bar will not update to reflect the new map scale. So, if 
you need to convert a map element to a graphic, you should not do this until 
your map layout is complete and you will no longer make changes to scale 
or symbology. 

Once a map element is converted to a graphic, its components can be 
ungrouped so that they can be moved and edited separately. This can be 
accomplished by right-clicking 
on the element of interest 
and selecting Ungroup. 
Below, is an example of the 
legend elements once they 
have been Ungrouped. 

 

 

Again, the reason why you may choose to convert map elements to graphics 
and ungroup them is so that they can be edited like graphic elements. 
Clicking on the elements will open formatting panes to edit the 
characteristics of the object, such as the text.  

Once a graphic object has been 
ungrouped, it can be grouped again. 
This can be accomplished by 
selecting multiple objects, right-
clicking, then selecting Group.  
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Tip 14: Exporting to a Vector Format 

You may find that you need to do additional map editing in vector graphics 
editing software, such as Adobe Illustrator or InkScape. To do this, you will 
need to export your map to a vector format that maintains the vector 
graphic components, such as text.  

To export to a vector format, navigate to the Share Tab. Click on 
the Layout button.  

You will then need to save the file in a vector format, such as EPS, 
SVG, or AI. This will allow for later editing in a vector graphics editing 
software.  

Tip 15: Locking Map Elements 

If you do not want to be able to further change map elements, they can be 
locked. This is useful if you want to make sure you do not accidentally alter 
a map element.  

To lock a map feature, simply click on the lock symbol next to it in the 
Contents Pane for the map layout. If you want to be able to edit it later, you 
can click on the lock again to unlock it.  

 

 

 

 

Final Comments 

We hope that you find these tips helpful. Note that there are many other 
components of map design in ArcGIS Pro that we do not have space to cover 
here. The best way to learn how to produce effective maps is to practice. So, 
we encourage you to make maps in ArcGIS Pro. With some practice and 
patience, you can become an effective cartographer. 

 

 

 

 

Lock  
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Deliverables 

You will be asked to deliver four maps for this assignment. Please deliver 
them as PDF files. Before you begin, we would suggest the following: 

1. Make a new project in which to create your maps.  
2. Create the four maps in four separate map layouts. 
3. Insert maps for each of the required map frames for the layouts. 
4. Save your work often. 

 

Map Exercise 1: Map of Visited European Countries (30 Points) 

Data for this map have been provided in the Exercise_10_Map1.gdb file 
geodatabase in the Exercise_10 folder downloaded from 
https://www.wvview.org/. You will need the following files: 
European_Countries and World_Countries. 

The “visited” field contains “0” and “1” values. “1” indicates countries that 
were visited during a hypothetical trip whereas “0” denotes European 
countries that were not visited.  

Your Task: Create a map of Europe showing what countries were visited 
and which weren’t. 

Grading Rubric: 

1. The data frame background color is changed to blue. (3 points) 
2. Countries are labeled with a halo and with no overlap between 

labels. (3 points) 
3. A coordinate grid in latitude and longitude is provided, and no north 

arrow or scale bar is provided. (6 points) 
4. An appropriate projection is used for continental Europe. The 

projection is listed on the map in a text box. (2 points) 
5. The World_Countries layer is included in the map layout behind 

the European_Countries layer. (2 points) 
6. The European_Countries layer is symbolized to show countries 

visited and those not visited. The legend labels have been changed 
to “Visited” and “Not Visited” as opposed to “1” and “0.” (4 points) 

7. The legend displays only the European_Countries layer and no 
file names are included in the legend. (2 points) 

8. A descriptive title and your name are provided. (2 points) 
9. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

https://www.wvview.org/
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Map Exercise 2: Colorado River Basin (30 Points) 

Data for this map have been provided in the Exercise_10_Map2.gdb file 
geodatabase in the Exercise_10 folder downloadable from 
https://www.wvview.org/. You will need the following files: Colorado River, 
Colorado_River_Drainage_Basins, Colorado_River_States, and 
Colorado_River_Tributaries. 

A WVU logo has also been provided in the Same folder. It is called 
wvu_logo.jpg. 

Use one of the available base maps. You can use whichever you think is 
appropriate. Remember to cite the source of the base map. 

Your Task: Create a map of the Colorado River Basin that highlights the 
Colorado River, its tributaries, and the states that its basin intersects.  

Grading Rubric: 

1. The Colorado River and its tributaries are symbolized as blue lines. 
The Colorado river is displayed thicker than its tributaries. (2 
points) 

2. The basin boundary is hollow with the lines symbolized in a color 
other than blue. It is above the state boundaries. The state 
boundaries should also be displayed as hollow with an outline and 
in a different color than the state outlines. (4 points). 

3. In the legend, the features are named as follows and in the 
following order: Colorado River, Tributary Rivers, States, Drainage 
Basin. (4 points) 

4. A scale bar is provided in miles with the bar ending on an even one-
hundred value (for example, 200 mi). In the scale bar, mi is used 
instead of spelling out miles. (3 points) 

5. A north arrow is provided. The north arrow should not be large or 
take up a lot of space on the layout. (2 points) 

6. The WVU logo is added to the map. (2 points) 
7. The base imagery is used; however, it does not appear in the 

legend. A text box is used to denote the source of the data. (3 
points) 

8. An appropriate projection is used for the western United States. The 
projection is listed on the map in a text box. (2 points) 

9. A descriptive title and your name are provided. (2 point) 

https://www.wvview.org/
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10. The map is overall very neat and well organized. Spaced is utilized 
well, and the data are well presented (6 Points) 

 

Map Exercise 3: Subdivision Map (30 Points) 

Data for this map have been provided in the Exercise_10_Map3.gdb file 
geodatabase in the Exercise_10 folder downloadable from 
https://www.wvview.org/. You will need the following files: Narra_block, 
Narra_foot, and Narrabundah. 

You will display the Narra_block layer using the “LIFE_STG” field.  

Use one of the available base maps. You can use whichever you think is 
appropriate. Remember to cite the source of the base map. 

Your Task: Create a map of this development showing the life stage of the 
parcels.   

Grading Rubric: 

1. Parcels are symbolized using the LIFE_STG field. A different color is 
used to show each class. (4 points) 

2. Class names have been changed to lower case in the legend. (3 
points) 

3. No file names are used in the legend. (3 points) 
4. The Narrabundah boundary is displayed as a hollow polygon with an 

outline color different from the other features. (3 points) 
5. The building footprints are displayed as solid polygons in a different 

color than the other features. (2 points) 
6. A scale bar is displayed in kilometers with km used in the scale bar 

as opposed to kilometers. (2 points) 
7. A transparency of 30% is used to display the parcels. (2 points) 
8. The base imagery is displayed beneath the vector layers. (1 point) 
9. The legend has only the vector features listed. The base imagery is 

not listed. All file names have been removed. (2 points)  
10. A descriptive title and your name are provided. (2 points) 
11. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

 

 

 

https://www.wvview.org/
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Map Exercise 4: Mine Expansion Model (30 Points) 

Data for this map have been provided in the Exercise_10_Map4.gdb file 
geodatabase in the Exercise_10 folder downloadable from 
https://www.wvview.org/.  You will need the following files: Study_Extent, 
us_states, us_counties, and mine_probabilities. 

The mine_probabilities raster grid represents a spatial prediction of the 
likelihood of mine expansion in the portions of the study area extent that 
have coal seams present. A value of 1 represents high probability and a 
value of 0 represents low probability. These data were developed and used 
in the following publication: 

Strager, M.P., J.M. Strager, J.S. Evans, J.K. Dunscomb, B.J. Kreps, and A.E. 
Maxwell, 2015. Combining a spatial model and demand forecasts to map 
future surface coal mining in Appalachia, PLoS ONE, 10(6): e0128813. 

Your Task: Create a map of the probability of surface mine expansion. 

Grading Rubric: 

1. The map is zoomed to the extent of the entire study area, not the 
entire country. (2 points) 

2. The raster probability surface has been symbolized using a stretch 
and a color ramp other than grey scale that is appropriate for these 
data. (2 points) 

3. The study area extent has been displayed as a hollow polygon with 
a red outline and is labeled “Study Area Extent” in the legend. (2 
points) 

4. The United States counties are displayed behind the study area 
extent and raster output. They are not shown in the legend. (3 
points) 

5. The states layer is hollow and displayed above the counties with 
thicker lines to highlight the state boundaries above the county 
data. They are not shown in the legend. (3 points) 

6. A second data frame is used to show a subset of the data of your 
choice (should be zoomed in relative to the other frame). An extent 
indicator is used to show where this subset is on the larger map. (4 
points) 

7. Text box with short text indicating why you chose the zoom extent. 
Example: “Highest probability of expansion” or “West Virginia” (2 
points)  

8. An appropriate projection is used for the eastern United States. The 
projection is listed on the map in a text box. (2 points) 

https://www.wvview.org/
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9. An appropriate north arrow and scale bar are provided. The north 
arrow should not be large or take up a lot of space on the layout (2 
points) 

10. A descriptive title and your name are provided. (2 points) 
11. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

Map Exercise 5: Fernow Experimental Forest Geology (30 Points) 

Data for this map have been provided in the Exercise_10_Map5.gdb file 
geodatabase in the Exercise_10 folder downloaded from 
https://www.wvview.org/. You will need the following files: folds, 
fernow_boundary, geology_fernow, and hillshade. 

Your Task: Create a map of the geology around the Fernow Experimental 
Forest near Parsons, WV. 

Grading Rubric: 

10. Use the provided layer files to symbolize the geology and folds 
layers (geology_legend.lyr and fold_legend.lyr). (3 points) 

11. The Fernow boundary should be displayed as hollow with an outline. 
(3 Points) 

12. The geologic layer should be displayed with transparency over the 
hillshade. (3 Points) 

13. The legend should include only the folds, Fernow boundary, and 
geology. No file or field names should appear in the legend. Do not 
include the hillshade in the legend. (6 points) 

14. Include a north arrow and scale bar. They should be well formatted 
and placed. (3 points) 

15. Include the following citation on the map as text: “Matchen, D.L., 
Fedorko, N., Blake, Jr., B.M. 1999.  OF9902 – Geology of Canaan 
Valley, West Virginia Geologic Survey Open File Map (Digital Data)” 
(3 Points) 

16. A descriptive title and your name are provided. (3 points) 
17. The map is overall very neat and well organized. Space is utilized 

well, and the data are well presented (6 Points) 

Map Exercise 6: US Population Change Hot Spot Map (30 Points) 

Data for this map have been provided in the Exercise_10_Map6.gdb file 
geodatabase in the Exercise_10folder downloaded from 
https://www.wvview.org/. You will need the following files: 
hot_spot_00_10 and states. 

https://www.wvview.org/
https://www.wvview.org/
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Your Task: Create a map showing hot spots and cold spots of population 
change between 2000 and 2010. Using the provided symbology, red 
indicates clusters of counties that have seen a population increase, blue 
indicates clusters of counties that have seen a population decrease, and tan 
represents no clustering pattern.  

Grading Rubric: 

1. Symbolize the county-level hot spot data using the provided layer file 
(hot_spot_00_10.lyr). (3 points) 

2. Include the state boundaries as hollow with a thick border over the 
county-level data. (3 Points) 

3. Use the Lambert Conformal Conic Projection and state the projection 
on the map as text. (3 Points) 

4. Include a well formatted and placed north arrow and scale bar. (3 
Points) 

5. Include a citation for the US Census. (3 Points) 
6. Include your name and a descriptive title. (3 Points) 
7. The legend should include only the county-level hot spot information. 

No file or field names should appear in the legend. Change the labels 
as shown below (6 Points) 

 
8. The map is overall very neat and well organized. Space is utilized well, 

and the data are well presented (6 Points) 

 

 

Map Exercise 7: Germany Reference Map (30 Points) 

Data for this map have been provided in the Exercise_10_Map7.gdb file 
geodatabase in the Exercise_10 folder downloaded from 
https://www.wvview.org/. You will need the following files: major_cities, 
major_rivers, states. 

https://www.wvview.org/
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Your Task: Create a general reference map of Germany that shows the 
following: major rivers (Rhine, Danube, Elbe, and Odra), major cities, and 
German states. 

Grading Rubric: 

12. Symbolize the German state boundaries using the “NAME” field. 
Each state should be assigned a color using a nominal color 
scheme. Do not label the states on the map. (3 Points) 

13. Label the major cities on the map. Use the “CITY_NAME” field. The 
labels should be easy to read. (3 points) 

14. Label the major rivers using the “NAME” field. The labels should be 
easy to read. (3 points) 

15. Find a picture of the German flag and add it to the map. (3 Points) 
16. Include a well formatted and placed north arrow and scale bar. (3 

Points) 
17. Include your name and a descriptive title. (3 Points) 
18. The legend should include the states, rivers, and city symbology. 

Make sure the state names are in the legend. No file or field names 
should appear in the legend. (3 Points) 

19. Include graticules (latitude and longitude grid). Make sure the 
labels are large enough to be easily read. Make sure the markings, 
lines, and ticks are not too dense. (3 Points) 

20. The map is overall very neat and well organized. Spaced is utilized 
well, and the data are well presented (6 Points) 

 

Map Exercise 8: New Jersey Land Cover (30 Points) 

Data for this map have been provided in the Exercise_10_Map8.gdb file 
geodatabase in the Exercise_10 folder downloaded from 
https://www.wvview.org/. You will need the following file: nj_nlcd_2011. 

Your Task: Create a layout from the 2011 NLCD land cover for New Jersey. 

Grading Rubric: 

1. Symbolize the raster grid by using a different color for each land 
cover class that seems appropriate for that class. The NLCD legend 
can be found here: https://www.mrlc.gov/data/legends/national-
land-cover-database-2011-nlcd2011-legend. No file or field names 
should appear in the legend. (6 Points) 

https://www.wvview.org/
https://www.mrlc.gov/data/legends/national-land-cover-database-2011-nlcd2011-legend
https://www.mrlc.gov/data/legends/national-land-cover-database-2011-nlcd2011-legend
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2. Include an inset map that shows the land cover in more detail over 
a selected section of New Jersey. Add an extent indicator on the 
main map to show where the inset map is in the state. (6 Points) 

3. The legend should include a label for each land cover class. Do not 
include the raster grid codes. Use the names of each class. (3 
Points) 

4. Cite the National Land Cover Database 2011 on the layout. (3 
Points) 

5. Include a well formatted and placed north arrow and scale bar. (3 
Points) 

6. Include your name and a descriptive title. (3 Points) 
7. The map is overall very neat and well organized. Spaced is utilized 

well, and the data are well presented (6 Points) 

 

Deliverables 

For this lab, provide your four maps in PDF format. They will be graded 
against the rubrics above. 

 

END OF EXERCISE 

 


